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Modulo 1

Diagndstico genético de las Enfermedades Raras.

OBJETIVOS GENERALES:
e Actualizar los conocimientos en el manejo de las enfermedades raras.
e Conocer el diagnéstico genético de las EERR.

e Conocer el proceso de la sospecha clinica al diagndstico y tratamiento de las
EERR.

e Conocer los principios basicos de la terapia génicay terapia celular en EERR.
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SERGEN HRyC

Equipo multidisciplinar trabajando por y para el paciente
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El mapa del genoma humano

Del cromosoma a kos genes
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LAS MUTACIONES SON ERRORES
EN LAS PAGINAS DEL MANUAL

@ - L=,

= L= X

Una sola copia defectuosa: Herencia dominante



AAAAAAA

LAS MUTACIONES SON ERRORES
EN LAS PAGINAS DEL MANUAL

& - L= Y

@ - L= X

Dos copias defectuosas: Herencia recesiva
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CAMBIOS DE UNA SOLA BASE

SNP Mutacion
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CAMBIOS EN MAS DE UNA BASE

Mutacion

N

poblacion
General
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ooooooooooo A QUE RETO NOS
ENFRENTAMOS
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Sanger vs NGS sequencing

Sanger NGS
. I -

B
GAGGGC[AGGIGCTA  GAGGGC[GGG|GCTA
100 90

Solo analizamos un

fragmento de un gen -Analizamos miles de genes en
paralelo

Secuencia A: sano

Secuencia B: paciente -Obtenemos cientos de mutaciones
en un individuo por comparacion con

Mutacion: A>G un genoma de referencia

-Debemos filtrar y priorizar aquellas
que sean “Patogénicas”
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vomerecrse  Enfarmedades raras

« Una enfermedad se considera rara cuando el niumero
de personas afectadas es inferior a 5:10000 (1/2000).

 Hay mas de 6000 enfermedades raras.
« EI 80% con una base genética.

« El 75% de las enfermedades raras afectan a los ninos.

« 30% de los pacientes de enfermedades raras mueren
antes de los 5 afos.

« En Europa hay mas de 30 millones de personas
afectadas de una enfermedad rara

« En Espafia hay mas de 3 millones de personas
afectadas.

Page last updated: January 2024


http://www.eurordis.org/about-rare-diseases
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Resecuenciacion: genoma, exomay panel de genes

IMPORTANTE: es resecuenciacion porque hay un genoma de referencia

Genoma:
Ventaja: no requiere enriquecimiento (“seleccionar los blancos”)

Desventajas: baja profundidad (10-12x), alto coste

Exoma: solo las regiones codificantes (con o sin UTRS)
Ventaja: mayor profundidad (~50x) que el genoma a menor coste
Desventajas: requiere enriquecimiento,
profundidad intermedia, problemas de cobertura

Panel: sélo algunas regiones de interés

Ventaja: maxima profundidad (>250x), menor coste

Desventajas: requiere enriquecimiento,
puede haber problemas de cobertura
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Neurogenetics
100 genes

Cardiology
74 genes

Clinical Exome

Genome (3x10° Bp)

Exome (1x10° Bp)
ca. 20,000 genes

MGPS
200 genes

Clinical exome (1x10” Bp)

ca. 4.800 genes
W Epileptic Severe intellectual @ Autism spectrum B Schizophrenia
encephalopathies disability disorders

BCORL1

CACNATI
HUWE1
KIAAT109

GABRB3
GRIN2B
SCN1A

Pathologies sharing symptons TRRAP

GNAO1

Genes involved in several patologies KIAAZ018
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That Is the question

Size

v

Complexity
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Read Budget is platform specific and determines multiplexing capacity

Read budget requirements differ for different applications

Genome

Methylome

Whole transcriptome
Exome

Targeted gene expression
Fusion transcripts

Somatic mutation detection

Structural variants
Germline SNP
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Caso problema 1
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Clinical features of the family

) Fistulas Fositas ) )
Paciente Hipoacusia
Branquiales Preauriculares
1:2 - - -
I1:1 + + HM
1:2 ’ i H.C

H.C= hipoacusia conductiva

H.M= hipoacusia mixta

A= agenesia renal

C= malformaciones cocleares

T= malformaciones del tubo o conducto auditivo
P= Fisura del paladar, L= labio leporino
R= desprendimiento de retina

M= miopia

V= anomalia vitrea congénita

Ce= ceguera

- = ausencia del fenotipo

+= presencia del fenotipo

Anomalias

Renales

Anomalias

Oculares

Anomalias
del Oido

Otros

P, Ce



IAVANTE

NOMBRE CURSO

BOR syndrome

—

Hinnaciisia
Encitac arifirine) nraaniviniilaracg
TUCIIGAO \Uriivivy) U vaun it oo

Anomalias renales

—
—

Fistulas branquiales
Anomalias del pabellon auricular

Lesion preauricular
Stenosis del conducto lagrimal
Paladar corto

Retrognatia: Mandibula posterior o retrasada

Tumor benigno intracraneal
Fisura del Paladar

Displasia congénita de las caderas
Bocio tiroideo

Paralisis de los nervios faciales
Excesiva secrecion lagrimal
Quistes en el pancreas

Otros

STICKLER syndrome

mmm)  Anomalia de la audicién/sordera

Cataratas

Miopia

Hiperlaxitud ligamentaria
Desprendimiento de retina

Astigmatismo

Fisura palatina
Hidartrosis/artrosis

Nariz plana

Retraso mental moderado / ligero
Ceguera

Paladar corto
Retrognatia/micrognatia

Epifisis anomalia

Cara plana
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GENOTYPING

COL2A1 12q13.1 <mmm

) COL11A1 1p21
Sindrome STICKLER COL11A2 6p21.3

COLY9Al1 69l12-913
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Sequencing analysis

COL2A1

Glu Glu Gly Lys Arg Gly Ala Arg

GAA'GAAGGCAAGAGA'GGT GCC'CGT

A e

Glu Glu Gly Leu Pro Val Glu Ser

wild type

GAA'G AA'GGCOTTGAGCCCGRGTHG AGAGOH

l €.1468_1475delinsT

p.Lys490_Gly492>LeufsX136
2
£
<
El
E

p.Lys490 Gly492>LeuFsX136
1:2: 11:1; 11:2
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Sequencing analysis

EYAl COL2A1

Gly Leu Avg Met Glu
Glu Glu Gly Lys Arg Gly Ala Arg

G G A'CT G GATGGAA
GAA'GAAGGCAAGAGA'GGT GCC'CGT

ot T A

Gl Leu Stoy
Y d Glu Glu Gly Leu Pro Val Glu Ser

GAAGAA'GGCOTTGAGCCCOCGRGTAHRG AGAGO

c.982C>T
p.Arg328X

wild type
wild type

€.1468_1475delinsT
p.Lys490_Gly492>LeufsX136

mutante
mutante

First case reported of BOR-STICKLER
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Caso problema 2
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Sordera congénita— 1 in 500

v

¥

Causas ambientales (20%)

Causas genéticas (80%)
|

* Rubeola/CMV
* Ototoxicidad...

A

y

v

Sindrémica (30%)

No-Sindromica
(70%)

¢ Usher Syndrome
e Waardenburg Syndrome
e Alport Syndrome

y

A 4

Recesiva
(80%)

Dominante
(20%)

~ 130 genes

>1500 mutaciones identificadas
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»  Se estima que su prevalencia en la poblacion general es de 1:50.000

«  El sindrome de Alport esta causado por mutaciones en los genes que
codifican colagenos tipo IV.

* Segun la herencia se pueden clasificar en

— SALX (ligado al X)
» El mas frecuente: 80% al 85% de los casos
+ Causado por mutaciones en el gene COL4A5

— SAAR (recesivo)
* 15% de los casos
» Causado por mutaciones en los gene COL4A3 o COL4A4

- SAD (formas dominantes)
+ Eslaforma mas rara afecta aproximadamente al 5% de los casos
» Causado por mutaciones en los genes COL4A3.

AUTOSOMICO LIGADO
RECESIVO AL CROMOSOMA X

B O0®0

NEFROPATIA DEL
COLAGENO IV (a3-a4) SAAR SALX
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Sindrome de Alport

Manifestaciones clinicas

— Renales: fallo renal

Hematuria: en el 100% de hombres y méas del 90% de las mujeres
afectadas tienen microhematuria en caso de SALX

Proteinuria, hipertension e insuficiencia renal desarrollan con la edad
todos los hombres con SALX y en todos los hombres y mujeres con
SAAR

— Auditivas

Sordera neurosensorial bilateral progresiva afectando a frecuencias
altas

— Oculares

Lenticono (parte central del cristalino con una protuberancia) Se
produce en el 15% -20% de los casos y tipicamente se hace evidente
en la adolescencia tardia o en etapa adulta temprana.

motas perimaculares ocurren en aproximadamente el 30% de los
individuos con sindrome de Alport.
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Sindrome de Alport

« Diagnostico / pruebas.
— Historia y examen fisico, que puede incluir
» audioldgica
* renal
« Oftalmologica

— Historia familiar detallada
« analisis de orina en familiares de primer y segundo grado

— El analisis inmunohistoquimico de la expresion basal de
colageno IV
« usando piel
* y/o muestras de biopsia renal
— El examen de las muestras de biopsia renal mediante
microscopia electronica.

— Diagnostico genético
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Sindrome de Alport

Table 1. Characteristics of COL4A5, COL4A3 and COL4A4 genes and the corresponding proteins.

COL4A5! COL4AS? COL4A4
Gene name NP_033380.2 NP_000091.4 NP_000092.4
Chromosomal location Xg22 2q35-37 2q35-37
Family *COL4AT-like *COL4A 1-like *COL4A2-like
Number of exons 53 52 48
Size 257,623 bp 150,228 bp 159,344 bp
Total number of amino acids in mature protein 1665 1642 1652
Signal peptide 26 28 38
Amino terminus 15 14 23
Collagenous domain (residues) 1301 1268 1284
Number of non-collagenous interrruptions 22 23 26
Carboxy terminus (residues) 229 232 231

*COL4A-like or COL4A2-like genes represent families that have arisen from common progenitors, COL4A1 or COL4A2, and thus have structural similarities

Table 2. Frequency of variants in COL4A5, COL4A3 and COL4A4 genes in LOVD databases.

COL4A5LOVD COL4A3LOVD COL4A4 LOVD
Total number of variants 1168 unique (1951 total) 266 unique (518 total) 268 unigue (490 total)
Rearrangements or deletions, copy number variants 76 (7%) 0 3(1%)
Duplications 13 (1%) 3 (1%) 4(1%)
Insertions 55 (5%) 8 (3%) 8(3%)
Deletions (1-26bp) 169 (14%) 31 (12%) 32 (12%)
Indels (with both insertions and deletions) 16 (1%) 3(1%) 2 (1%)
Splicing variants 273 (152+ and 121-)* (23%) 25 (15+and 10-)* (9%) 52 (25+ and 27-)* (19%)
Nonsense codons (direct) 73 (6%) 13 (5%) 13 (5%)
Total potential nonsense mutations (direct and downstream) 329 + 73 = 402 (34%) 45 + 13 = 47 (18%) 13 + 49 = 62 (23%)
I Missense substitutions 504 (43%) 136 (51%) 107 (40%)

= Gly 391 (33%) 66 (25%) 46 (17%)

= Non-Gly 113 (10%) 70 (26%) 61 (23%)
Non-pathogenic changes 24 78 65

= Synonymous 11 44 28

= Non-Gly missense 7 28 14
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DIAGNOSTICO BASADO EN NGS:
EXOMA CLINICO

T -

DNA sample

Library preparation

for NGS Massive Parallel Sequencing:
MiSeq (150pb paired end)

. @==m Raw Data Sequence A
Sequencing QC (FastQ files)
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Summary | Detals | Analysis Inf

.-

Variant studio

Raw reads (DAT files, BCL files)

Demultiplexing
g
Deconvoluted reads (FASTQ files)

Alignment to reference genome
Aligned reads (BAM files)

Coverage calculation, local alignment

On target alignment

Variation analysis
e

Mutation analysis

Filtration
&
Mutation filtering
Mutation annotation
Clinical annotation
Clinical
report

QC raw and QC passed run yield, read quality,
run parameters

[QC barcoding deconvolution, sample read distribution]

[QC alignment (mapping quality), library complexity]

QC coverage depth, coverage uniformity, allelic
frequency, strand bias, GC content

[QC negative and positive controls]
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DATOS DE

SECUENCIACION
EXOMA CLINICO

Enrichment Sequenc

Read Level Enrichment

lumina

ng Report

Sample Information

Sample ID: 2
Sample Name: C36
R iSeqAnalysis\170505_M03€98_0090_000000000-AWT4M

al PF Read 28,198,724

Percent Q30: 1%

Adapters Trimmed: |Yes

Median Read Length: | 151 bp

Total Aligned | Percent Aligned
Reads
28,072,916 [ 99.6% P

Targeted Aligned | Read Padded Target |Padded Read
Reads nrichment | Aligned Reads | Enrichment
15,070,002 53.7% 17,056,563 60.8%

Base Level Enrichment

Total Aligned | Targeted Aligned | Base Padded Target | Padded Base
Bases Enrichment | Aligned Bases | Enrichment
3,974,974,952 | 1,534,283,978 38.6% 2,331,065,819 | 58.6%

Software Versions

Coverage Summary

Mean Region

Uniformity of Coverage | Target Target Target Target

Coverage Depth | (Pct > 0.2*mean) Coverage |Coverage |Coverage | Coverage
at 1X at 10X at 50X
96.3% 99.4% |98.4% (97.2% J)[89.3%

Software

Version

Isis (Analysis Software)

2623

BWA (Aligner)

0.7.9a-isis-1.0.1

SAMtools

0.1.18 (r982:295)

GATK (Variant Caller)

v1.6-23-gf0210b3

Picard (Calculate HS Metrics) | NA
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© Tllumina VariantStudio — =

| Home | Amnotaton &Classification  Reports  Help @
L 1 = | select Al Save As Default
[ Open E ﬂ g ?‘ m 9 - A smaller
. o ¥ Current Sample: Current: - = Ey save | [} Copy Apply Default
New [4 Close ©S°ve SaveAs | Import AddVarants Import Remove Manage A Larger
A VCF to Sample  Folder Sample Favorites [_] column Order Restore Default
Project Samples 9 Filter Favorites Table Options Layout “

Filters 2 || Gene View LS

General v

Variant v

’ 1 Inherited | AltVariant Read AltRead Allelic Custom | C

ene . Gene Variant  Chr  Coordinate Classification Type  Genotype | Exonic Fiters  Quality — GOX — o ta | T | Toe | srmee |

¥

Consequence v

Population Frequency v

Cross Sample Subtraction v

Family Based »

Custom v

Classification ~

Apply Filters =>
W44 VariantOofD b W oW 4T v
Show Population Frequendies Show Transeript Info Show Custom Annotations Show ClinVar Show Cosmic

Clear Filters

Variant studio

4:
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= ]
Variant studio
Home Annotation & Classification Reports Help o @
5 LE R I | Select All
U = open Q Q ﬁ* r_l = A Smaller
Current Sample: 5562_52 - Current: - By save | [¥ Copy
New i o Save Save As | Import Add Variants Import b - Remaove : Manage AL Layout
ose arger
- VCF to Sample  Folder Sample Favorites [} column Order 9 -
Project Samples Filter Favarites Table Options
Filters 1 || Gene View a2
General v
Variant v
T R . Inherited Alt Read Alt | Alle -
o Gene Variant = Chr Coordinate Classification Type  Genoty... Exonic Filters Quality GQX From Variant | Depth | Read | Depi
5
Consequence v » | AGRN T>T/C 1 977330 snv het yes PASS 71004 99 57,8 64 37 27,3
Fopulation Frequency - AGRN A>AlG 1 981931 het yes PASS 111455 99 37 124 44 75,4
AGRN T=T/C 1 982994 het yes PASS 1209205 99 354 147 52 85,5
Cross Sample Subtraction b AGRN T>T/C 1 984302 het yes PASS 42660 99 52,5 40 21|18,2
AGRN C>CfT 1 987200 het yes PASS 101723 99 54,3 70 38 32,3
Family Based v
AGRN C>TT 1 990280 hom yes PASS 122720 93 100 41 41 0,41
Custom v TAS1IR3 T>C/C 1 1269554 hom yes PASS 600635 99 100 210 209 0,20
CDK11A C>C/G 1 1647778 snv het yes PASS 56358 99 28,6 98 28 70,2
SEEUELT M CDK11A T>T/C 1 1647814 sy het yes  PASS 55030 99 27,5 102 28 74,2
CDK11A T>T/C 1 1647871 snv het yes PASS 43570 99 24,5 94 23/71,2
CDK11A c>CfT 1 1647893 snv het yes Lowi... 900 9 8,8 80 7737
CDK11A A>AlG 1 1647928 snv het yes PASS 146278 99 84,5 58 49 9,49
CDK11A CTIT 1 1653028 snv hom yes PASS 219828 99 100 67 67 0,67
GABRD T>T/C 1 1957037 s het yes PASS 197493 99 58,6 128 75/53,7
SKI C>CfA 1 2235818 snv het yes Lowi... 332 3 11,1 27 3243
PEX10 c>CfT 1 2337277 snv het yes PASS 122403 99 51,6 93 48 454
PEX10 T=T/C 1 2340200 snv het yes PASS 139031 99 44,3 141 62 78,6
MMELL T>C/C 1 2528133 snv hom yes LowDP 37626 30 100 11 116,11
MMEL1L G>AA 1 2560882 hom yes PASS 76868 54 100 36 36 0,36
MMELL T>G/G 1 2560003 hom yes PASS 67506 48 100 30 30 0,20
TF73 CTT 1 3638674 hom yes PASS 455319 99 100 144 144 0,14
MPHP4 T>T/C 1 5926507 het yes PASS 65154 99 58,7 46 27 19,2
MPHP4 ASTIT 1 5035162 hom yes LowDP 57044 45 100 15 15 0,15
MNPHP4 G=G/A 1 5937168 het yes SB 18849 99 28 25 7 18,7
MPHP4 G=>G/A 1 5940243 snv het yes PASS 100459 99 50,6 83 42 41,4
KCNAB2 T=>C/C 1 6142308 snv hom yes PASS 214141 99 100 74 74 0,74
_ KCNAB2 6158562 sV het yes PASS 100884 99 48,1 81 39 42,3 7
TS w4 4 veriant1orazse WY w4 ’
Clear Filters ShuwW Show Transcript Info Show Custom Annotations Show Clinvar Show Cosmic
Variants | Genes | Mo-Call Regions ‘

[ —
Filter History

. fanan ATESY w fanen aToc
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Variant studio

©) = )& [ x
Home Annotation & Classification Reports Help &
O (L) = ) Select All
u = Open 3 3 r\‘ |—_§ — _ﬁ\ 82 A Smaller
New Save Save As | Import Add Variants Import ELpBEs e 5sa2_s2 T Remove Current: M Manage & save & <l Layout
[ Close A Larger
A VCF to Sample  Folder Sample Favorites 1] column order E b
Project Samples Filter Favorites Table Options
Filters 2 || Gene View r
General v
Edit Included Gene List (3
Variant v
: Inherited Alt Read At Alle <
cone R Gene Variant Filters Quality ~GQX From Variant | Depth  Read Depl
L] Gene List
Disease » AGRN T>T/C ggﬂg PASS 71004 99 578 64 37273
AGRN A>AG COL4A4 PASS 111455 99 37 124 44 75,4
[ Include List Cl acry T>T/C PASS 120205 99 354 147 52 95,5
D Bxclude List E AGRN T>T/C PASS 42660 99 52,5 40 21 19,2
AGRN C>C/T PASS 101723 99 54,3 70 38 32,3
[ Min Variant Alleles 2 |[acru oTIT PASS 122720 03 100 41 41 041
. TAS1R3 T>C/C PASS 600635 99 100 210 209 0,20
D where custom gene annotatior
o CDK11A c=Cle PASS 56358 929 28,6 28 28 70,2
contains: CDK11A T>T/C PASS 55030 99 275 102 28 74,2
(@) AND OR CDK11A T>T/C PASS 43570 99 24,5 94 23 71,2
[”] where optional gene annotatio | | cpk11a c>ofT Low... 900 9 8,8 80 7 73,7
contains: CDK11A A>AlG PASS 146278 99 84,5 38 49 9,49
CDK11A C>T/T PASS 219828 929 100 67 67 0,67
EoEELeTEE v GABRD T>T/C PASS 197493 99 58,6 128 75 53,7
P e . KT c>c/A Low... 32 3 i1 27 3243
PEX10 c>CfT PASS 122403 99 5L6 93 48 43,4
Cross Sample Subtraction & PEX10 T>T/C PASS 139031 99 443 141 62 78,6
Family Based " MMEL1 T>C/C LowDP 37626 30 100 11 11 0,11
MMEL1 G>AlA PASS 76868 54 100 36 36 0,36
Custom v MMEL1 T>G/G PASS 67506 48 100 30 30 0,30
TF73 C>T/T PASS 455319 99 100 144 144 0,14
Classification v
NPHP4 T>T/C PASS 65154 99 58,7 46 27 19,2
NPHP4 A>TIT LowDP 57044 45 100 15 15 0,15
NPHP4 G>G/A SB 18849 99 28 25 7 18,7
NPHP4 G>G/A 1 5940243 RN ) het yes PASS 100459 99 50,6 83 42 41,4
KCNAB2 T>C/C 1 6142308 sy hom yes PASS 214141 99 100 4 74 0,74
KCNAB2 A>AlG 1 6158562 = sny het yes PASS 100884 929 48,1 81 39423 7
Apply Filters => M4 4 Variant1of 9756 > » W v
Clear Filters Show Population Frequencies Show Transcript Info Show Custom Annotations Show ClinVar
Variants | Genes | No-Call Regions |

Filter History
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Variant studio

Filter History

©) Tumina VariantStudio — & ]x
Home | Annotation & Classification Reports Help o @
b (L 2 I Select All
|_| = Open 3 Q n‘ |’A -9 = “A Smaller
New Save SaveAs Import Add Variants Import Current Sample: | SS62_S2 7 Remove Current: M Manage B save | L) Cony Layout
[ Close A Larger
- VCF  toSample  Folder Sample Favorites 1] cotumn order 9 -
Project Samples Filter Favorites Table Options
Filters 2 || Gene View L]
General v
Variant v -
. o Inherited Alt Read At Allelic
cone N Gene Variant = Chr Coordinate Classification Type  Genoty... Exonic Filters Quality = GQOX From Variant | Depth Read Depths
v
By » COL4A3 T>C/C 2 228111435 snv hom  yes PASS 120430 90 100 38 380,38
COL4A3 A>G/G 2 228113175 snv hom  yes PASS 383908 99 100 121 1210421
Include List C|| |coteas CT/T 2 228128540 snv hom  yes PASS 98482 75 100 30 300,30
] Exclude List [ |couas G>G/A 2 228128568 het yes PASS 48880 99 447 47 212621
coL4A3 A>A/G 2 228131169 het yes FPASS 88776 99 40,9 88 365236
[C] Min Variant Alleles 2| coLaas G-G/A 2 228131752 snv het yes PASS 218283 99 585 142 83 59,83
coL4A3 c¢T 2 228135631 snv het yes PASS 125899 99 50 83 49 34,49
[] where custom gene annotatiar
COL4A3 QT 2 228158021 snv het yes PASS 74309 99 453 64 293529
mm‘”s: coLand G>G/A 2 227872182 snv het yes PASS 136918 99 50,9 108 55 53,55
(@) AND OR COL4A4 T>T/IC 2 227872995 snv het yes  PASS 51153 99 42,3 52 22 30,22
[ where optional gene annotatio | | coraad A>A/G 2 227873028 snv het yes PASS 56049 99 468 47 2232522
contains: COL4A4 A>AIG 2 227886773 snv het yes  PASS 113654 99 51,1 88 45 43,45
coLand T 2 227892619 het yes PASS 123476 99 554 83 46 37,46
CoEeence M coL4as CCoT 2 227892720 het yes PASS 97218 99 543 70 383238
Population Frequency . coLand €C/c 2 227896652 snv het yes PASS 95551 99 441 93 415241
coL4A4 T 2 227896886 snv het yes PASS 101232 99 551 69 383.,38
Cross Sample Subtraction = coL4Ad cegT 2 227896976 snv het yes  PASS 72660 99 45,2 62 28 34,28
Family Based . coL4A4 G>G/A 2 227954599 het yes PASS 107814 99 495 93 4647.46
COL4AS ©TT X 107823778 hom  yes PASS 203878 99 100 59 590,50
Custom v COL4AS G>G/GT X 107827760 - insertion  het yes RS 5055 51 86 22 6 15,6
Classification ~
Apply Filters => .
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) Tlumina Variantstudio

J Home | Annotation & Classification Reports Hel

Dew M B &4 @ B

Select All
’-; ?\ B A Smaller
" 5 coveis | mport Add varonts Tmpory CUTTETt Sample: 5562 52 I Current: ] B Save | [V Copy Lavout
oW 4 Close SOVe Save As | Impol ariants  Impo emove anage “A Larger ayou
- VCF  toSample  Folder Sample Favorites 1] column Order g -
Project 7 Samples p Filter Favorites a Table Options
Filters 1 || Gene View »
Variant v
Inherited Alt Read Alt Allelic
cene . Gene Variant | Chr Coordinate  Classification Type  Genoty... Exonic Fiters  Qualty | Gx Mgt RE S L epths
¥
Disease
» COL4A3 /T 2 228158021 het yes PASS 74309 99 45,3 64 29 35,29
COL4AS oT/T X 107823778 hom yes PASS 203878 99 100 59 59 0,59
Include List
COL4AS G>G/GT X 107827760 = insertion  het yes R8 5055 51 28,6 22 6 15,6

[] Exclude List

[ Min Variant Alleles

[N @)

[] where custom gene annotatior

contains:

l

@) AND OR
[] where optional gene annotatio

contains:
Consequence ~

Popul Tequency ~

Global Frequency <
American Pop

Asian Pop Frequen

@]
S
O

B European Pop
B EVS Frequency <

Set all to:

Apply Filters =>

Filter History

N e S e

Show clinvar Show Cosmic
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Por qué es necesario el binomio clinico-genetista?

El abordaje multidisciplinar permite Illegar a un diagndstico certero en base al
reanalisis clinico-genético

A proposito de un caso de sospecha de
sindrome de Alport.....7777?
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=0
5O
50

l:1 [:2 1:3

*ll:l index case with suspected Alport Syndrome

*No mutations detected by Trusight One in the Alport virtual panel
*Simplex case? Lack of penetrance?

«Alport Syndrome? BOR syndrome? Other?
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B-Gal Activity (units)

Familia SS70: BOR syndrome?????

I, @
111 1:2
SIX5 MUT/WT WT/WT

. 5

1:1 11:2 11:3
SIX5 MUT/WT WT/WT WT/WT
REPORT

E, Mutacién descrita en SIX5 que no segrega
p.(Gly365Arg) c.1093G>A

Transcription Factor S/X5 Is Mutated in Patients
with Branchio-Oto-Renal Syndrome

Bethan E. Hoskins, Carl H. Cramer II, Derek Silvius, Dan Zou, Richard M. Raymond ]Jr.,

Dana ]. Orten, William ]. Kimberling, Richard J. H. Smith, Dominique Weil, Christine Petit,

Luciferase Activity (units)

Mutations in SIX5 reduce its ability to activate transcription

Edgar A. Otto, Pin-Xian Xu," and Friedhelm Hildebrandt* of the MEF3 promoter.
Table 1. Clinical and Genetic Data on Five Patients with SIX5 Mutations
Hearing Nucleotide Amino Acid

GALA AD-EyaiD- "Proy” Patient  Branchial Defect Loss Renal Defect Change Change
A441 PT? - DK® c.4726—A A158T
AGT7 CFHM® PS™ PM® 4L ++%  DK® | function A296T
416 365!

™ = ™
A500 P ++5 42 AL HER €.16550=T T552M
Note.—— = absent, + = affected, ++ = more affected; ' = left, ¥ = right, ® = bilateral; PT =

A = agenesis; ND = no data available.

2007 Apr;80(4):800-4. Epub 2007 Feb 22.

preauricular tag, DK = dysplastic kidneys, CF = cervical fistulae, HM = hemifacial microsomia, PS = preaur-
icular sinus, PM = pinna malformation, ! function = diminished renal function, HK = hypoplastic kidneys,

i

i

i

i

i

i


https://www.ncbi.nlm.nih.gov/pubmed/17357085
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Population Frequencies

. Allele Allele Number of Allele
Population - * * * A
Count Number Homozygotes Frequency NM_ITSETS A(SDX5):¢.1080G>A [p Glyd6SArg)
; EEEE— —_— venior 0 © o 1 Aected gene
East Asian 1 206 il 0.002591 Potew st © 500 s ot roaces SO hemesbar 3

uropean {Mon- 1 4346 1] 0.00023m
Finnish)

Interpretation @

African o ff i
e syvdoms 2 s - M [ —

European (Finnish) 0 52 0 0 . L
Latino 0 348 0 0 pen®

115825 ASEXS . VGO . GRSt
Other 1] 136 1] 1]
South Asian 1] 7a12 1] 1] o Viewst
_— i
Total 2 13452 0 0.0001487 e

Retsted mformation

od

¢ Mutacion? EN SIX5 p.(Gly365Arg) ¢.1093G>A
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Familia SS70: IGV analysis

Ha19_cheM_fixed ol v | chrz:107,841,968-107,880,145 o ft 4« » @O x4 | Sl rgin
7]
1
38KD
107 850k 107,560 kb 107570k 107,68
1 1 1 1 1 1
v
—_—
C72_82.bam Coverags
C72_s2bam
v
(AT -
NE4_S2.bam Covarags
No4_52 bam
2
bom -
SS70-1_81.bam Covarags
L . i . .
S570.1_31.05m
2
¥ A \ y A ~
Gene f
Ex30 al 36
g
g
3
-4
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Exon 29 Exon 3.:}

M1 11 12 152 103 1 121 12 1:2 103
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Familia SS70

[ @ L]
|11 |:2 13
WT/- Mut/WT
\ Delecion exones 30 al 36
! SN
11:1 11:2 1:3
Mut/- Mut/WT WT/WT
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Consideraciones y reflexiones:

1- La investigacion traslacional es el motor que permite la implantacion progresiva de la NGS en la
practica clinica para el diagndstico de las enfermedades raras

2- Ningun método diagndstico es infalible.....Ia NGS tampoco.

Mas puede ser menos

3- Paneles vs exoma clinico.

4- Factores como la estructura de la familia, la posibilidad de obtener datos clinicos fiables, la
posibilidad de crear binomios formados por genetista-clinico especializados en grupos de
patologias hereditarias concretas, la realizacion de ensayos funcionales......etc.....determinaran en
gran medida el poder reducir el nimero de variantes con significado incierto (VUS).



FORMAC]ON IAVANTE Fundacién Progreso y Salud

CENTRO DE SIMULACION
CLINICA AVANZADA

@IAVANTE_FPS | #|AVANTEsimulacion |

Gracias por su atencion
www.lAVANTE.es



http://www.iavante.es/

